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Help with an area of the screen.

Please click on the link next to the area of the screen you are interested in to receive help on it.

Current Region

Center Map

Section Selected

Game Info
Name:    Jon Doe
Difficulty Level:    Easy
Number of moves:    0
Time elapsed:    0:00:00
Percent solved:    0%

Background





Screen Component:    Current Region

The current region is the part of the display that shows a portion of the Rubick’s Hypercube.    It 
shows a region of the Rubick’s Hypercube along with the cubes attached to it.    If you are viewing the 
Rubick’s Hypercube in Full View, it shows the entire Rubick’s Hypercube, and it looks like this:



Screen Component:    Center Map

The center map is a picture of 8 cubes that shows where the middle cubes are in each region of 
the Rubick’ s Hypercube.    This is useful because the positions of the middle cubes do not change in 
relation to each other.    A good way to solve the Rubick’s Hypercube is to line up all of the cubes in each 
region to the same color as the middle cube.



Screen Component:    Section Selected

The section selected indicates which section you have selected.    A section is a part of the 
Rubick’s Hypercube that can be rotated.    In easy mode, there are 9 different sections that you can rotate.
In hard mode, you can only rotate an entire region at a time.



Screen Component:    Game Info

Name:    Jon Doe
Difficulty Level:    Easy
Number of moves:    0
Time elapsed:    0:00:00
Percent solved:    0%

The game info shows you certain information about the current game, such as whether you are in hard or 
easy mode, how much time has elapsed, and how many moves you have made (only moves that change 
the Rubick’s Hypercube are counted).



Screen Component:    Background

The Background of the Rubick’s Hypercube shows a watermark of me (the author) along with the words 
‘’Rubick’s Hypercube’’.



Tutorial
Welcome to Rubick’s Hypercube!

The following is a tutorial that will take you through a walk-through of the game.    You’ll learn what
a Rubick’s Hypercube is, how to use this program to solve one, and how to contact the author of this 
game.    

A Rubick’s Hypercube is a 4-dimensional extension of the ordinary 3-d Rubick’s Cube.    The 
Rubick’s Hypercube has several things in common with the Rubick’s Cube.    The Rubick’s Cube has 3 
different kinds of pieces, pieces with one color (middle pieces), two colors (edge pieces), or three colors 
(corner pieces).    Similarly, the Rubick’s Hypercube has 4 different kinds of pieces, pieces with one color 
(middle pieces), two colors (face pieces), three colors (edge pieces), and four colors (corner pieces).    
Also, because the Rubick’s Hypercube has an extra dimension, the colored sides are 3-dimensional 
cubes rather than flat squares.

Piece Name Number of colored cubes in 
piece

Total number of these pieces in 
Rubick’s Hypercube

Center Piece 1 8

Face Piece 2 24

Edge Piece 3 32

Corner Piece 4 16

Click here to go to the next page



Rubick’s Hypercube Tutorial:    page 2

The goal of the Rubick’s Hypercube is to solve the Rubick’s Hypercube such that every side has 
cubes that are all the same color, much like the oridinary Rubick’s Cube having all of the sides contiain 
squares of all the same color.    The difference is, a side of the Rubick’s Hypercube is a 3-dimensional 
cube, rather than the square side of a Rubick’s Cube.    Here is an example of what a solved Rubick’s 
Hypercube looks like:
One Region View All Region View

Click here to go to the next page



Rubick’s Hypercube Tutorial:    page 3

Now, on to playing the game.    There are two versions of the Rubick’s Hypercube.    The easy 
version is easier and allows a wider variety of moves.    The hard version is harder and is more limited in 
the number of moves that you can do.    We’ll start with the easy version.    If you haven’t already opened a
Rubick’s Hypercube game, open one now by double clicking on “RubicksHypercube.exe”.    When it asks 
which version you wish to play, select “Easy Version”.    If you have already started a game, make sure 
that the text in the upper right hand side of the screen indicates that the difficulty level is set to “easy”.    If 
not, go up to the menu and click ‘’Game’’, then ‘’Switch Version’’.    Ok, now that you have a game running
and are in easy mode, click the button that looks like this  in the Rubick’s Hypercube window.    This will
shrink the window to one half of the screen.    Next, resize this help window to fill the other half of the 
screen.    If you don’t know how to do that, click here.    Now you should be able to see both windows at 
the same time.    These next pages of the tutorial will take you through a walk-through of the game.

Click here to go to the next page



How to Resize a Window:
In order to resize a window, simply move the mouse over the edge of the window, until the pointer looks 
like this .    Dragging the mouse when it looks like this will allow you to resize the window.    You can 
also move the window around by dragging on the Title Bar at the top of the winodw.    The title bar looks 
like this:    

Click here to go back to the tutorial



Rubick’s Hypercube Tutorial:    page 4

Ok, now that you have the Rubick’s Hypercube window open, click on the button in the left toolbar

that looks like this:    .    This selects the back section of the Rubick’s Hypercube.    The buttons in this 
group of nine allow you to select any of the nine sections in the current view.    The red area in the big 
cube at the left side of the screen indicates which section is selected.    This is the section that will rotate 
when you click a rotation button.

Now click the button that looks like this:    .    This button rotates the cubes in the current 
section in the direction indicated (In this case, clockwise).    Now try clicking the button that looks like this:  

 and then the the button that looks like this 

.    As you can see, you can rotate any of the sections in any direction you wish, much like an ordinary
Rubick’s Cube.

Suppose you made a mistake on that last move.    Rubick’s Hypercube has commands in the Edit 
menu that let you undo and redo your moves (Undo and Redo, respectively).    You can undo all of your 
moves all the way down to your first move, and you can redo them all the way back to the first move you 
undid.    You will also notice a command in the edit menu called ‘’Replay moves’’.    This replays all of the 
moves you did in the game.    Finally, the ‘’Reset’’ button the Edit menu resets the Rubick’s Hypercube to 
it’s original state (before you did any moves on it).    Be careful with this command, because you cannot 
undo the Reset command.

Rubick’s Hypercube also has a File menu.    The file menu has the standard commands that most 
file menus have.    For a more detailed description of how to use the file menu, and shortcuts for file menu 
commands, click here.

Click here to go to the next page



The File menu of Rubick’s Hypercube.
The File menu of Rubick’s Hypercube has several commands.    The first command is the ‘’New’’ 

command.    This creates a new randomly scrambled Rubick’s Hypercube.    There is also a shortcut to 

this command in the toolbar at the top of the screen:    .    There are also commands that let you save
a file ‘’Save’’ 

, and save with a new name ‘’Save As’’.    Once you’ve saved a file, you can open it with the ‘’Open’’ 
command under the file menu, or click 

.    Also, the file menu has a list of recently used files that you can open just by clicking their name 
where they appear in the File menu.    Finally, there is the ‘’Exit’’ command.    This is how you quit the 
game.    You can also exit the game by clicking the 

 button in the upper right hand corner of the screen.

Command Toolbar shortcuts Keyboard shortcuts

New Ctrl+N, Alt+F N

Open Ctrl+O, Alt+F O

Save Ctrl+S, Alt+F S

Save As none Alt+F A
1, 2, 3, ... none Alt+F (1, 2, 3, ...)
Exit     (Upper right corner) Alt+F X

Click here to continue with the tutorial
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One important button that can help you out is the Context Sensitive Help button.    It looks like this

.    When you click on it, the pointer changes to a question mark with an arrow.    You can then click on
anything in the Rubick’s Hypercube window to get help on it.    When you’re done with this tutorial, try 
using this button to get help on anything you still don’t understand.    Ok, here’s something you can do 
now:    Click on the 

 button.    This will show you information telling you which version of Rubick’s Hypercube you have, 
along with the date it was completed, and the author’s name and email address.

The Rubick’s Hypercube is more than what you see in the Rubick’s Hypercube window right now. 

Click on the  button to see all of it.    As you can see, the Rubick’s Hypercube consists of 8 regions.    
What you were seeing before was just one of these regions, plus all of the cubes that were attached to it 
from the adjacent regions.    You’ll notice the middle cube in each of these regions is a little bit larger than 
the other cubes.    

The middle cubes are larger because they are the most important cubes in the Rubick’s 
Hypercube.    They can never be scrambled.    They are just like the middle pieces in a regular Rubick’s 
Cube, they only have one color, and they can never be scrambled.    If you’ve ever taken a Rubick’s Cube 
apart, all of the pieces are seperate from each other, except for the middle cubes.    These cubes are 
attached directly to the center, and they can rotate around, but they never move into different positions 
reltive to each other and to the center.    Therefore, they serve as a good guide to solving the Rubick’s 
Cube.    The same is true of the middle pieces of Rubick’s Hypercube.    These cubes are so important, I 
thought you should be able so see them at all times, therefore I have made a ‘’Center Map’’ that shows 
you where all of these cubes are.    That is what the little cubes are on the left side of the screen just 
below the big cube with the red section in it.    These are the middle cubes from each of the 8 sections.    

Now click the  button.    Now we’re back to seeing only part of the Rubick’s Hypercube.    Notice that 
there is a little cube in the middle of the Center Map, and it is the same color as the cube in the center of 
the region of cubes shown on the screen.    Now it’s time to try out some of the other buttons.

Click here to go to the next page
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Ok, try clicking the  button.    This brings you up one region to the one above the one you 
were just at.    Now, observe the color in the middle of this region.    Notice that it is the same as the color 
in the middle of the Center Map.    Now look at the cube below this one in the Center Map.    It is the same 
color as the middle cube in the region you were at before.    Click on the 

 button to go back down.    Notice the color of the cube in the middle of this region.    The Center Map 
is a valuable tool because it tells you the color of the middle cube in each of the eight regions, the regions
above, below, to the left of, right of, in front of, and behind you, as well as the middle cube where you are 
now, and the one at the other end of the Rubick’s Hypercube (that is the one that is two cubes below the 
middle in the Center Map).    By now you probably have a good idea what the buttons with the straight 
yellow arrows do.    But now let’s try the buttons with the curved yellow arrows.

Click on the  button.    You will see the region you are looking at rotate in the direction of the 
yellow arrow.    But not only has the region you were looking at rotated, the entire Rubick’s Hypercube has
rotated.    Try to think of the yellow buttons as similar to turning a regular Rubick’s Cube in your hand to 
look at different parts of it, or see it from a different angle.    It doesn’t change the Rubick’s Cube itself, it 
just changes the way you look at it.    Same thing for the yellow buttons and the Rubick’s Hypercube.    
There are two more buttons you should know about.    These are the animation button 

 and the perspective button 

.    Try clicking the perspective button now.    As you can see, perspective has now been turned off.    
All of the cubes are now the same size, instead of the cubes that are farther away looking smaller and the
ones that are nearer looking larger.    The animation button turns animation on and off.    (For those with 
slower computers, it may be helpful to turn the animation off, otherwise, I recommend leaving animation 
on all the time).

Lastly, there is the hard version of Rubick’s Hypercube.    This version is harder because you are 
only allowed to rotate one entire region at a time, therefore there are no buttons for selecting a section, 
and no cube with a red section selected.    Instead, there are 6 rotation buttons for rotating the current 
region clockwise and counterclockwise about the x, y, and z axes.    You can toggle between the easy and
hard versions by selecting Game~Switch Version from the menu at the top of the screen.    If you solve 
the easy version of the Rubick’s Hypercube, try the harder version.

This tutorial has covered most of the buttons and menus in Rubick’s Hypercube.    If there is a 
button or menu item this tutorial has not covered, but you want to know more about it, use the context-

sensitive help button .
By now you should have a good overview of the game.    If you have any problems with the game 

or questions you can’t find answers to in this help file, feel free to email me at berglunb@pop.rose-
hulman.edu.



File menu commands

The File menu offers the following commands:

New Creates a new document.
Open Opens an existing document.
Close Closes an opened document.
Save Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.
Exit Exits Rubick's Hypercube.



Edit menu commands

The Edit menu offers the following commands:

Undo Undoes your last move.
Redo Redoes a move previously undone.
Reset Resets the Rubick’s Hypercube to it’s original state.    (undoes all of your 

moves).
Replay 
moves

Replays all of the moves you have done.



View menu commands

The View menu offers the following commands:

Toolbars Shows or hides the Custom Toolbar.
Status Bar Shows or hides the status bar.



Game menu commands

The Game menu offers the following commands:

Switch Version Brings up a dialog box to let you switch between the hard and easy versions.
Change Name Brings up the box that asks you your name so you can change it.
Create High 
scores file

Create a high scores file.    This can be used for a high scores table, such as 
the one at http://www.rose-hulman.edu/~berglunb/Rubick/highscores.html



Help menu commands

The Help menu offers the following commands:

Help Topics Displays a list of topics you can get help on.
About Displays the copyright notice and version number of your copy of Rubick's 

Hypercube.



New command (File menu)

Use this command to create a new document in Rubick's Hypercube.

You can open an existing document with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)

Use this command to open an existing document.

You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name
Type or select the filename you want to open.    This box lists files with the extension you select in the List 
Files of Type box. 
List Files of Type
Select the type of file you want to open:
Rubick’s Hypercube files are files with extension “.rhc”
Drives
Select the drive in which Rubick's Hypercube stores the file that you want to open. 
Directories
Select the directory in which Rubick's Hypercube stores the file that you want to open.
Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)

Use this command to close all windows containing the active document.    Rubick's Hypercube suggests 
that you save changes to your document before you close it. Before closing an untitled document, 
Rubick’s Hypercube displays the Save As dialog box and suggests that you name and save the 
document.

You can also close a document by using the Close icon on the document's window, as shown below:



Save command (File menu)

Use this command to save the active document to its current name and directory.    When you save a 
document for the first time, Rubick's Hypercube displays the Save As dialog box so you can name your 
document.    If you want to change the name and directory of an existing document before you save it, 
choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active document.    Rubick's Hypercube displays the Save As 
dialog box so you can name your document.    

To save a document with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to save:
File Name
Type a new filename to save a document with a different name.    A filename can contain up to eight 
characters and an extension of up to three characters.    Rubick's Hypercube adds the extension you 
specify in the Save File As Type box.
Drives
Select the drive in which you want to store the document.
Directories
Select the directory in which you want to store the document.
Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four documents you 
closed.    Choose the number that corresponds with the document you want to open.



Exit command (File menu)

Use this command to end your Rubick's Hypercube session.    You can also use the Close command on 
the application Control menu.
 
Shortcuts
Mouse: Double-click the application's Control menu button.

Click the Exit button on the right side of the Title Bar.

Keys: ALT+F4



Undo command (Edit menu)

Use this command to undo your previous move.    Some moves (such as resetting the Rubick’s 
Hypercube) cannot be undone.    If it is not possible to undo a move, or there are no moves to undo, this 
command appears grayed in the menu.

Shortcuts
Keys: CTRL+Z



Redo command (Edit menu)

Use this command to redo a move previously undone.    If there are no undone moves to redo, this 
command appears grayed in the menu.

Shortcuts
Keys: CTRL+Y



Reset command (Edit menu)

Use this command to reset the Rubick’s Hypercube to it’s original state before you perfomed moves to it.   
Warning!    This command cannot be undone.



Replay Moves command (Edit menu)

Use this command to replay all of the moves you have done in the current game.    The time elapsed is 
adjusted to not include the time it took to replay the moves.



Toolbars command (View menu)

Use this command to display and hide the toolbars, which include buttons for many commands in 
Rubick's Hypercube, such as Perspective.    A check mark appears next to the menu item when the 
toolbars are displayed.    It is recommended that you do not hide the Custom Toolbar (toolbar on the left), 
because some of the commands in Rubick’s Hypercube can be accessed only through the Custom 
Toolbar.

See Toolbars for help on using the toolbars.



Toolbars

Rubick’s Hypercube has 2 different toolbars.    Please select which toolbar you’d like more help on.

Main Toolbar

Custom Toolbar



Toolbar

The main toolbar is displayed across the top of the application window, below the menu bar.    The main 
toolbar provides quick mouse access to many tools used in Rubick's Hypercube,

Click To

Open a new document.

Open an existing document.    
Rubick's Hypercube displays the Open dialog box, in which you can locate and open the desired file.



Save the active document or 
template with its current name.    If you have not named the document, Rubick's Hypercube displays the 
Save As dialog box.

Obtain help on some portion of 
Rubick's Hypercube.

Display author, author’s email 
address, and version number of your copy of Rubick's Hypercube.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the 
selected menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to 
the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the Rubick's Hypercube window.    To display or hide the 
status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of toolbar buttons as you 
depress them, before releasing them.    If after viewing the description of the toolbar button command you 
wish not to execute the command, then release the mouse button while the pointer is off the toolbar 
button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using Rubick's Hypercube and various types of reference information.    

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the author, author’s email address, and and version number of your copy of 
Rubick's Hypercube.

Shortcuts

Toolbar:



Context Help command 

Use the Context Help command to obtain help on some portion of Rubick's Hypercube.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.   
Then click somewhere in the Rubick's Hypercube window, such as another Toolbar button.    The Help 
topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title 
bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 
border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable when the window is maximized (In Rubick’s Hypercube the window 
is maximized by default).

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note:    This command is unavailable when the window is maximized (In Rubick’s Hypercube the window 
is maximized by default).

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the Rubick's Hypercube window to an icon.

Shortcut
Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.    By default, Rubick’s 
Hypercube maximizes the window.

Shortcut
Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the document 
Control menu closes only one window at a time.    You can close all windows at once with the Close 
command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the Rubick’s Hypercube window or dialog box

Mouse: Click  on the right 
side of the window’s Title Bar.



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.

Shortcut

Mouse: Click  on the right 
side of the window’s Title Bar.



Custom Toolbar

The custom toolbar is displayed along the left side of the application window.    The custom toolbar 
provides quick mouse access to many tools used in Rubick's Hypercube.

Buttons Name Do the following

        

   

       

Side to be rotated buttons. Select which side you wish to 
rotate.



              OR

        

        

Direction of rotation buttons. Select which direction you 
want to rotate the side you 
have selected.



   

   

        

   

Shifting buttons. Shift you to a different area of 
the hypercube.



View buttons. Select how you want to view 
the hypercube.



Animation, and Perspective. Turn animation and 
perspective on and off.



Direction of Rotation buttons (Custom Toolbar).
The direction of rotation buttons determine whether you want to rotate the current section clockwise or 
counterclockwise, and if you are in hard mode, which axis to rotate about.

Click To More Help

          The following are buttons used only in easy mode.

Rotate the current section clockwise. Rotate Clockwise

Rotate the current section counterclockwise. Rotate Counterclockwise

          The following are buttons used only in hard mode.

Rotate the current region clockwise about the y-axis. Rotate Clockwise (Y)

Rotate the current region clockwise about the z-axis. Rotate Clockwise (Z)

Rotate the current region clockwise about the x-axis. Rotate Clockwise (X)

Rotate the current region counterclockwise about the y-
axis.

Rotate Counterclockwise (Y)



Rotate the current region counterclockwise about the z-
axis.

Rotate Counterclockwise (Z)

Rotate the current region counterclockwise about the x-
axis.

Rotate Counterclockwise (X)

Side to be rotated buttons (Custom Toolbar).

The ‘side to be rotated’ buttons determine which part of the hypercube you want to rotate.    These buttons
only apply in easy mode.    For more information about how the sides are named, see the page on the 
definition of directions in Rubick’s Hypecube.    The picture above shows the side selected indicator, which
indicates which side of the Rubick’s Hypercube is currently selected.

Click To More Help



Select the leftmost cubes in the current view. Left Section

Select the middle layer of cubes (perpendicular to the y-
axis) in the current view.

Middle Section (Y)

Select the rightmost cubes in the current view. Right Section



Select the topmost cubes in the current view. Top Section

Select the middle layer of cubes (perpendicular to the z-
axis) in the current view.

Middle Section (Z)

Select the bottommost cubes in the current view. Bottom Section



Select the frontmost cubes in the current view. Front Section

Select the middle layer of cubes (perpendicular to the x-
axis) in the current view.

Middle Section (X)

Select the backmost cubes in the current view. Back Section

View buttons (Custom Toolbar)
These change your view of the Rubick’s Hypercube, whether you see all of it at once, or only part of it.

Click To More Help



Show the entire Rubick’s Hypercube unfolded. One Region View

Show just one region of the Rubick’s Hypercube. Full View



Shifting buttons (Custom Toolbar)
These buttons move you from one region of the Rubick’s Hypercube to another, or to rotate the entire 
Rubick’s Hypercube about an axis.    These actions do not change the Rubick’s Hypercube.

Click To More Help

Move to the region left of the current one in the Rubick’s 
Hypercube.

Shift Left

Move to the region above the current one in the Rubick’s
Hypercube.

Shift Up

Move to the region behind the current one in the 
Rubick’s Hypercube.

Shift Back

Move to the region in front of the current one in the 
Rubick’s Hypercube.

Shift Forward



Move to the region below the current one in the Rubick’s 
Hypercube.

Shift Down

Move to the region right of the current one in the 
Rubick’s Hypercube.

Shift Right

Rotate the entire Rubick’s Hypercube clockwise about 
the x-axis.

Shift Clockwise (X)

Rotate the entire Rubick’s Hypercube clockwise about 
the y-axis.

Shift Clockwise (Y)



Rotate the entire Rubick’s Hypercube clockwise about 
the z-axis.

Shift Clockwise (Z)

Rotate the entire Rubick’s Hypercube counterclockwise 
about the x-axis.

Shift Counterclockwise (X)

Rotate the entire Rubick’s Hypercube counterclockwise 
about the y-axis.

Shift Counterclockwise (Y)



Rotate the entire Rubick’s Hypercube counterclockwise 
about the z-axis.

Shift Counterclockwise (Z)



Rotate Clockwise button (Custom toolbar)

This button rotates the current section selected in the clockwise direction.



Rotate Counterclockwise button (Custom toolbar)

This button rotates the current section selected in the counterclockwise direction.



Rotate Clockwise (Y) button (Custom toolbar)

This button rotates the current region in the clockwise direction about the y-axis.



Rotate Clockwise (Z) button (Custom toolbar)

This button rotates the current region in the clockwise direction about the z-axis.



Rotate Clockwise (X) button (Custom toolbar)

This button rotates the current region in the clockwise direction about the x-axis.



Rotate Counterclockwise (Y) button (Custom toolbar)

This button rotates the current region in the counterclockwise direction about the y-axis.



Rotate Counterclockwise (Z) button (Custom toolbar)

This button rotates the current region in the counterclockwise direction about the z-axis.



Rotate Counterclockwise (X) button (Custom toolbar)

This button rotates the current region in the counterclockwise direction about the x-axis.



Left Section button (Custom toolbar)

This button causes the current section selected to be the leftmost section in the current region.    The left 
section contains 30 cubes and rotates around the y-axis.    This button only applies in easy mode.



Top Section button (Custom toolbar)

This button causes the current section selected to be the topmost section in the current region.    The top 
section contains 30 cubes and rotates around the z-axis.    This button only applies in easy mode.



Back Section button (Custom toolbar)

This button causes the current section selected to be the backmost section in the current region.    The 
back section contains 30 cubes and rotates around the x-axis.    This button only applies in easy mode.



Middle Section (Y) button (Custom toolbar)

This button causes the current section selected to be the middle section (with respect to the y-axis) in the 
current region.    This middle section is sandwiched between the left and right sections, contains 21 cubes 
and rotates around the y-axis.    This button only applies in easy mode.



Middle Section (Z) button (Custom toolbar)

This button causes the current section selected to be the middle section (with respect to the z-axis) in the 
current region.    This middle section is sandwiched between the top and bottom sections, contains 21 
cubes and rotates around the z-axis.    This button only applies in easy mode.



Middle Section (X) button (Custom toolbar)

This button causes the current section selected to be the middle section (with respect to the x-axis) in the 
current region.    This middle section is sandwiched between the front and back sections, contains 21 
cubes and rotates around the x-axis.    This button only applies in easy mode.



Right Section button (Custom toolbar)

This button causes the current section selected to be the rightmost section in the current region.    The 
right section contains 30 cubes and rotates around the y-axis.    This button only applies in easy mode.



Bottom Section button (Custom toolbar)

This button causes the current section selected to be the bottommost section in the current region.    The 
bottom section contains 30 cubes and rotates around the z-axis.    This button only applies in easy mode.



Front Section button (Custom toolbar)

This button causes the current section selected to be the frontmost section in the current region.    The 
front section contains 30 cubes and rotates around the x-axis.    This button only applies in easy mode.



Full View button (Custom toolbar)

The full view button shows the entire Rubick’s Hypercube unfolded (shown at right).    You will notice that 
the Rubick’s Hypercube is divided into 8 cube shaped regions, and each of these is divided into 3rds in 
each direction so that they each have 27 cubes.    This makes for a total of 216 cubes in the Rubick’s 
Hypercube.    Becuase it can be confusing looking at 216 cubes at once, by default Rubick’s Hypercube 
displays the smaller view, showing only 81 cubes at a time.



One Region View button (Custom toolbar)

The one cube view button shows one region of the Rubick’s Hypercube and the cubes connected to it.    
This is view that you see when you first open the program.    This view is also the only view that supports 
animation.



Shift Left button (Custom toolbar)

The Shift Left button moves you to the region to the left of the one you’re currently looking at.    This does 
not change the Rubick’s Hypercube, it just changes which part of it you are looking at.    It is similar to 
looking at a different side of an ordinary Rubick’s Cube.



Shift Up button (Custom toolbar)

The Shift Up button moves you to the region above the one you’re currently looking at.    This does not 
change the Rubick’s Hypercube, it just changes which part of it you are looking at.    It is similar to looking 
at a different side of an ordinary Rubick’s Cube.



Shift Back button (Custom toolbar)

The Shift Back button moves you to the region behind the one you’re currently looking at.    This does not 
change the Rubick’s Hypercube, it just changes which part of it you are looking at.    It is similar to looking 
at a different side of an ordinary Rubick’s Cube.



Shift Forward button (Custom toolbar)

The Shift Forward button moves you to the regionin front of the one you’re currently looking at.    This 
does not change the Rubick’s Hypercube, it just changes which part of it you are looking at.    It is similar 
to looking at a different side of an ordinary Rubick’s Cube.



Shift Down button (Custom toolbar)

The Shift Down button moves you to the region below the one you’re currently looking at.    This does not 
change the Rubick’s Hypercube, it just changes which part of it you are looking at.    It is similar to looking 
at a different side of an ordinary Rubick’s Cube.



Shift Right button (Custom toolbar)

The Shift Right button moves you to the region right of the one you’re currently looking at.    This does not 
change the Rubick’s Hypercube, it just changes which part of it you are looking at.    It is similar to looking 
at a different side of an ordinary Rubick’s Cube.



Shift Clockwise (Y) button (Custom toolbar)

The Shift Clockwise (Y) button shifts the entire Rubick’s Hypercube clockwise about the y-axis.    This 
does not change the Rubick’s Hypercube, it just changes your view of it.    It is similar to looking at an 
ordinary Rubick’s Cube from a different angle.



Shift Clockwise (Z) button (Custom toolbar)

The Shift Clockwise (Z) button shifts the entire Rubick’s Hypercube clockwise about the z-axis.    This 
does not change the Rubick’s Hypercube, it just changes your view of it.    It is similar to looking at an 
ordinary Rubick’s Cube from a different angle.



Shift Clockwise (X) button (Custom toolbar)

The Shift Clockwise (X) button shifts the entire Rubick’s Hypercube clockwise about the x-axis.    This 
does not change the Rubick’s Hypercube, it just changes your view of it.    It is similar to looking at an 
ordinary Rubick’s Cube from a different angle.



Shift Counterclockwise (Y) button (Custom toolbar)

The Shift Counterlockwise (Y) button shifts the entire Rubick’s Hypercube counterclockwise about the y-
axis.    This does not change the Rubick’s Hypercube, it just changes your view of it.    It is similar to 
looking at an ordinary Rubick’s Cube from a different angle.



Shift Counterclockwise (Z) button (Custom toolbar)

The Shift Counterclockwise (Z) button shifts the entire Rubick’s Hypercube counterclockwise about the z-
axis.    This does not change the Rubick’s Hypercube, it just changes your view of it.    It is similar to 
looking at an ordinary Rubick’s Cube from a different angle.



Shift Counterclockwise (X) button (Custom toolbar)

The Shift Counterclockwise (X) button shifts the entire Rubick’s Hypercube counterclockwise about the x-
axis.    This does not change the Rubick’s Hypercube, it just changes your view of it.    It is similar to 
looking at an ordinary Rubick’s Cube from a different angle.



Animation button (Custom toolbar)

The Animation button turns animation on or off.    Unless you have a slow processing speed, and you think
you can solve the Rubick’s Hypercube faster without animation, it is recommended you leave the 
animation on.    It makes it easier to keep track of your moves.    Also please note that if you are in Full 
View mode, there will never be animation.    To see the animation, it is recommended you stay in the One 
Region View mode, and only use the Full View mode occasionally to view your progress in solving the 
Rubick’s Hypercube.



Perspective button (Custom toolbar)

This button turns perspective on and off.    Some people find it easier to see where the cubes are without 
perspective turned on.    Others prefer the perspective because it gives them a better perception of depth.



Help Topics command (Help menu)
Click this button to display a list of topics you can receive help on.



Switch Version command (Game menu)
The switch version command allows you to switch between the hard and the easy version of Rubick’s 
Hypercube.    For information about the difference between the harder and the easier version, see 
Versions.



Change Name command (Game menu)
When Rubick’s Hypercube starts up, it asks you for your name.    If you ever need to change that name for
any reason, use the Change Name command in the Game menu.    If you solve the Rubick’s Hypercube 
and decide you want your name listed in a high scores table, this is the name that will appear in that table.



Create High Scores File command (Game menu)
Now, with version 5200+, you can create a high scores file.    This can be done at any point in the game.    
This is a file that is encrypted and if you email it to the author of this program at berglunb@pop.rose-
hulman.edu, he will decrypt the information and you can have your name appear on the high scores table.



Versions.

There are two versions of Rubick’s Hypercube availible, an easier version and a harder version.    The 
difference between the versions is in the type of moves you are allowed to do.    In the easier version, you 
are allowed to rotate every section in the current region, in the harder version, you can only rotate an 
entire region at a time.    Both versions are guaranteed solvable because the program internally scrambles
the Rubick’s Hypercube, starting from a perfectly solved Rubick’s Hypercube using the same moves that 
you are allowed to do.    In the harder version, the custom toolbar does not have as many buttons.    There
are more Direction of Rotation buttons, but no Side to be rotated buttons, because the program does not 
need to know which section you want to rotate -- you must rotate the entire region.    You can switch 
between versions using the Switch Version command in the Game Menu.    You should take note that the 
Rubick’s Hypercube is rescrambled when you switch the version.



Definitions.
Rubick’s Hypercube uses certain ways of referring to things, such as a ‘section’ of the Hypercube, a 
‘region’ of the Hypercube, or the directions up, down, left, right, etc.    For the definition of a term used in 
this help file, click the appropriate link below.

Section
Region
Pieces
Directions (such as right, left, up, down, etc.)



Definitions:    Section

A section of the Rubick’s Hypercube is a certain group of pieces that can be rotated.    An example of a 
section is shown in red above.    A section may contain 21 cubes or 30 cubes, and always contains exactly
9 pieces.    In the harder version of this program, no sections are rotated, only entire regions, which 
contain 81 cubes (27 pieces).



Definitions:    Directions

The coordinate system in Rubick’s Hypercube is set up according to the standard right-handed system, 
with the z-axis pointing up, the x-axis pointing down and to the left, and the y-axis pointing down and to 
the right.    The curved arrows show the direction of clockwise rotation around each of these axes.    The 
six directions in Rubick’s Hypercube are:    up, down, left, right, forward, and backward.    These are 
shown on the right.    When we say the middle section with respect to the y-axis, we mean the section in 
between the left and right sections.    The middle section with respect to the x-axis is the section between 
the front and back sections, and the middle section with repsect to the z-axis is the section between the 
top and bottom sections.    A good way to remember which middle section is which is to remember that the
x-axis will go perpendicular through the center of the middle section (x), etc.



Definitions:    Region
A ‘region’ of the Rubick’s Hypercube is similar to a side of an ordinary Rubick’s Cube.    It contains 27 
colored cubes.    There are a total of 8 regions in the Rubick’s Hypercube, similar to the 6 sides of an 
ordinary Rubick’s Cube.    When you view just one region, you are actually seeing a little bit more.    It 
shows not only the cubes that are in one region (a total of 27), but also all of the cubes connected to 
these cubes (for a total of 81 cubes).    This is so that pieces do not get split up when you view them, you 
see 27 complete pieces.    When you look at these cubes, you will notice there is a 3x3x3 array of cubes 
in the middle, and to each face of the outside cubes that is facing outward, there is ‘glued’ another cube.    
This is the cube that is connected ‘around the corner’ in the 4th dimension.



Definitions:    Pieces
A piece of the Rubick’s Hypercube is the 4-d equivalent to one of the small cubes that make up an 
ordinary Rubick’s Cube.    The Rubick’s Hypercube contains a total of 80 pieces.    Much like the cubes of 
a Rubick’s Cube can have different numbers of colored faces based on their position, so the pieces of the
Rubick’s Hypercube can have different numbers of colored cubes based on their position.    Below is a list 
of the different types of pieces.    (Of course, all pieces have 8 cubes, but some of them are facing the 
inside of the Rubick’s Hypercube and are hidden from view, just like all cubes in a Rubick’s Cube have 6 
faces, but not all of them are colored, because some of them face the inside of the Rubick’s Cube)

Piece Name Number of colored cubes in 
piece

Total number of these pieces in 
Rubick’s Hypercube

Center Piece 1 8

Face Piece 2 24



Edge Piece 3 32

Corner Piece 4 16

*note:    the single colored cube of a center piece is often called a center cube.



Indicators
The indicators are little pictures in the left side of the Rubick’s Hypercube window that show current 
conditions, such as which side you have selected and your location within the Rubick’s Hypercube.    Click
on the links below for more help on a particular indicator.

Side Selected Indicator

Location Indicator



Indicators: Side selected

This indicates which section of the Rubick’s Hypercube is currenently selected.    You can use the side to 
be rotated buttons on the custom toolbar to change which section is currently selected.    This indicator will
not appear when you are in hard mode.



Indicators: Location Indicator (Center Map)

This indicates which region you are in.    The reason this program only shows you one region of the 
Rubick’s Hypercube at a time is that most people find that viewing the entire Rubick’s Hypercube all at 
once is too confusing.    If you wish to see the entire Rubick’s Hypercube, use the Full View button on the 
custom toolbar.    The colors of the cubes correspond to the colors of the center cubes of each region of 
the Rubick’s Hypercube, and so because it is a map of the center cubes, it can also be called a Center 
Map.    You’ll notice that the color of the cube in the center of the location indicator matches the color of 
the cube in the center of the region of the Rubick’s Hypercube you’re looking at.



Switching between hard and easy versions of Rubick’s Hypercube.
The version selector dialog box allows you to switch between the hard and the easy version of Rubick’s 
Hypercube.    It is automatically displayed when you start the program.

You can also switch between hard/easy versions after starting the program.    For more information, see 
the Switch version command.



Solving the Rubick’s Hypercube.
The Rubick’s Hypercube is solved when every region contains cubes of all the same color.    Another way 
of phrasing this is that every cube adjacent to a center cube is the same color as the center cube, 
because the center cubes do not change their position relative to each other.    Rubick’s Hypercube will 
display a message congratulating you if you solve the Rubick’s Hypercube.



Contacting the Author of Rubick’s Hypercube.
To report problems, ask questions, or if you just want to contact the author of this program, he can be 
reached via email at:    berglunb@pop.rose-hulman.edu



Dockbar.
The dockbar is a place where you can place the toolbar.    The toolbar then merges into the dockbar and 
then becomes part of the window.    You can also float the toolbar.    This makes the toolbar appear in a 
window of it’s own, apart from the main program window.    If you click the ‘’x’’ in the corner of the toolbar, 
it will disappear.    To make it reappear, you will need to use the Toolbars command in the View menu.    
*Note:    You may need to use this command twice to make the toolbars all reappear.



Rubick’s Hypercube File Type.

By default, Rubick’s Hypercube saves your files as ‘’.rhc’’ files.    This extension identifies a Rubick’s 
Hypercube file and distinguishes it from other file types.    You can also set Rubick’s Hypercube as the 
default program to open files of this type, allowing you to open ‘’.rhc’’ files just by double clicking on them.



*note: topics 90 and 91 should link to the same page
topics 92, 93, and 94 should link to the same page
topics 106, 107, 108, and 109 should link to the same page

1 2 3 4 5 6 7 8 9 10 11 12 13
14 15 16 17 18 19 20 21 22 23 24 25
26 27 28 29 30 31 32 33 34 35 36 37
38 39 40 41 42 43 44 45 46 47 48 49
50 51 52 53 54 55 56 57 58 59 60 61
62 63 64 65 66 67 68 69 70 71 72 73
74 75 76 77 78 79 80 81 82 83 84 85
86 87 88 89 90 91 92 93 94 95 96 97
98 99 100 101 102 103 104 105 106 107 108 109
110 111 112 113 114



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.




